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ABSTRACT 

The software engineering teaching practice is not possible without the use of a server. The server itself is comparatively 

expensive and undergoes complex construction environment. However, if a single machine is used as both the client and 

server, it is not that consistent with the actual production environment. A multifunctional server can be constructed with 

Raspberry Pi at a low price. So developed server does not need any peripheral kit except the power supply, hereby can 

be used to develop web applications and database management system suitably. Hence it becomes more in-built and 

easier for students to realize. 
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INTRODUCTION 

One of the characteristics of the software engineering major is that the theory is tested and strengthened through repeated 

trial and error in practice. The development of modern application software is inseparable from the server, which is 

different from the traditional stand-alone desktop application in the early days. Therefore, in order to save equipment, a 

single machine is generally used as a client (including a browser) and a server, which is not intuitive for students and is 

not the same as the actual production environment. 

Raspberry Pi is a card-type computer, only the size of a credit card. It has now developed to a 4B version with a 

maximum built-in memory of 4G, which can meet the basic needs of a simple server. The Raspberry Pi establishes a 

wireless connection through Wi-Fi and enables SSH, so that we can use software tools to use the desktop computer to 

enter Raspberry Pi commands; install an FTP server, and transfer files between the Raspberry Pi and the desktop 

computer. If we install the MySQL server on the Pi, we can use it to practice the development of network databases. If 

we build a Tomcat server on the Raspberry Pi then we can deploy Web applications to the Raspberry Pi. By connecting 

this Raspberry Pi to the power supply, without any external equipment, students in a dormitory can practice all the above 

tasks intuitively. 

 

OPERATING SYSTEM PROGRAMMING AND BASIC CONFIGURATION 

Raspberry Pi uses TF (T-Flash) card to install the system. In order to get better performance, we generally choose 

SanDisk 10-speed (write speed is 10MB/s), 32G capacity TF card. In addition, there are Ultra High Speed (UHS) TF 

cards, which achieves a writing speed of 30MB/s. A variety of operating systems can be installed on the Raspberry Pi. 

Generally, the official version (Debian version, one of the Linux distributions) in the document [1] can be downloaded. 

This version has good compatibility. This article will start with this version. In addition, the visualization effect of the 

Ubuntu MATE system is better, and network sharing can be achieved through the system that supports USB interface 

printers. Since there is currently no 4B version of the system, Windows 10 IoT Core system can better support IoT 

applications. However, the system cannot be burned directly so it needs to be installed online. 
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After the system image is downloaded, use the Win32DiskImager tool to write to the TF card, insert it into the 

corresponding slot in the Raspberry Pi, connect the keyboard, mouse and HDMI display, plug in the Internet cable, and 

power on. The initial startup needs to set the country (Country), language (Language) and time zone (Timezone) etc., 

check Use US keyboard (Use US keyboard), otherwise some characters cannot be output. The default user name is pi, set 

a user password you like. There is no need to set Wi-Fi, use the following command (1) to modify the settings, and (2) is 

the text content in the configuration. Now enter the DNS of an IP address. If there are multiple IP addresses, separate 

them with spaces.  

sudo nano /etc/dhcpcd.conf         (1) 

static domain_name_servers=114.114.114.114       (2) 

 

Since wired is much faster than wireless, we therefore enter the command sudo reboot, start the Raspberry Pi, and use the 

wired update system. The following command (3) reads the list of software packages that need to be updated, and (4) 

completes the system software update. If the update is not complete, you can add the parameter "--fix-missing", fix the 

missing packages, and restart the system.sudo apt-get update [--fix-missing]    (3) 

sudo apt-get dist-upgrade [--fix-missing]        (4) 

 

The burned Raspberry Pi has no root password in the initial state. During software installation and system configuration, 

root privileges are sometimes required. For better use of the system, you can use the shell command sudo passwd root to 

add the root password. 

 

SSH AND FTP INSTALLATION AND CONFIGURATION 

SSH connections are more secure than Telnet remote desktop connections and have become an industry standard. Log in 

to the Raspberry Pi using an SSH connection, and you can remotely control and program the Raspberry Pi. The 

Raspberry Pi ends up being a server that only needs to be connected to a power source, so an SSH connection needs to be 

configured so that you can enter remote commands. Installing an FTP server is convenient for transferring files between 

the desktop computer and the Raspberry Pi, so that even a U disk is not needed. 

 

Open the system settings through the command sudo raspi-config, select Interfacing Options -> SSH, set SSH Enabled, 

save and exit. Install the SSH service through the command (5), then open the /etc/rc.local file, and add the command (6) 

before the statement "exit 0", so that the SSH service can be automatically started at boot. Figure 1 shows the effect of 

establishing an SSH connection with the Raspberry Pi through the PuTTY tool and setting the parameters of the 

Raspberry Pi under the Windows 10 platform. 

sudo apt-get install openssh-server         (5) 

/etc/init.d/ssh start          (6) 

 

In Linux systems, there are many types of FTP servers to choose from. Very Secure FTP Daemon (vsftpd) - a very secure 

FTP process is a GPL-based FTP server running on a UNIX-like operating system. It supports many good features that 

other traditional FTP servers do not support. It is small and light, safe and easy to use; hence becomes very suitable for 

Fig. 1 Modify settings through SSH connection 
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Raspberry Pi. The FTP server is installed by command (7), and the service is started by command (8). But you need to 

set the local_enable variable in the /etc/vsftpd.conf file to YES (that is, to allow local access), and the write_enable 

variable to be set to YES (that is, to allow write operations) 

sudo apt-get install vsftpd          (7) 

sudo service vsftpd start          (8) 

After the configuration is complete, restart the Raspberry Pi, you can connect to the Raspberry Pi through the "ftp IP" 

command (replace IP with a specific address) on the desktop computer, and enter the username pi and the corresponding 

password configured in Section 1. After logging in successfully, use the lcd command to switch the local path, !dir 

displays the local directory and files; the cd command switches the remote path, and the ls command displays the remote 

directory and file. The put command uploads files to the Raspberry Pi (the default is the pi directory), get command to 

download files from raspberry pi (default pi directory). 

 

Although the SSH and FTP services are configured, the corresponding ports need to be opened through the firewall. The 

iptables of the Linux firewall is too cumbersome, and the ufw (abbreviation for ubuntu fireward) firewall tool is 

convenient and efficient to use. Use command (9) to install ufw firewall, command (10) to enable or disable the firewall; 

command (11) to close all ports by default; command (12) to open SSH default port 22 and command (13) to check the 

firewall status, that is, to open the number of ports available. Correspondingly, the FTP service needs to open the default 

port 21. The MySQL server to be installed below needs to open the default port 3306, and the Tomcat server needs to 

open the default port 8080, which can be adjusted according to actual needs. 

sudo apt-get install ufw          (9) 

sudo ufw enable/disable          (10) 

sudo ufw default deny          (11) 

sudo ufw allow 22          (12) 

sudo ufw status           (13) 

 

MYSQL DATABASE SERVER INSTALLATION AND CONFIGURATION 

MySQL is one of the most popular relational database management systems. It uses SQL language to access the database 

and has strong versatility. Currently, mainstream companies and organizations using this database include Facebook, 

Github, YouTube, Twitter, PayPal, Nokia, Spotify, Netflix, etc. MySQL software adopts a dual authorization policy, 

which is divided into community version (free) and commercial version. Due to its small size, fast speed, low total cost 

of ownership, especially open source, MySQL is generally chosen as the development of small and medium-sized 

websites. Website database, colleges and universities often use this database system for teaching. 

 

MariaDB database management system is a branch of MySQL, developed by Michael Widenius, the founder of MySQL. 

It adopts GPL license and is fully compatible with MySQL, including API and command line, making it an easy 

replacement for MySQL. The 4B version of the Raspberry Pi can only install MariaDB, and the (14) command here can 

complete the installation. In order to be able to access the MySQL database on the Raspberry Pi on other computers, we 

need to modify the bind-address in the file through the command (15), and change the local IP address "127.0.0.1" to 

"0.0.0.0". Set the MySQL root password by command (16). 

sudo apt-get install default-mysql-server        (14) 

sudo nano /etc/mysql/mariadb.conf.d/50-server.cnf       (15) 

sudo mysqladmin -u root -p password        (16) 

After the root password is changed, you can log in to the MySQL database. Use the following database commands to 

enable root remote login privileges. 

->USE mysql;  

->update user set host='%' where user='root' and host='localhost'; 

->update mysql.user set plugin='mysql_native_password' where user='root'; 

->FLUSH PRIVILEGES; 

->exit; 

After this configuration is completed, the MySQL database system can be accessed remotely through port 3306 of ufw, 

which is used to create databases and data tables, and perform search, modify, and delete operations. 
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ACCESS MYSQL DATABASE THROUGH VISUAL BASIC .NET 

Reference [2] implements a Windows-based transaction reminder software (the software name is WinAlarm), which 

facilitates the arrangement of office affairs. However, using the Access database requires the installation of Office office 

software, which is not convenient enough. If you are in a small company, you can put the affairs that need to be reminded 

into a MySQL server and share them through the desktop program to coordinate everyone's work. Here, Visual Basic 

.NET (Express 2019 version) is used to access the MySQL database, and a Windows transaction reminder software 

(WinAlarmMySQL) that supports MySQL is developed. The MySQL database is called by the development tool through 

the relevant driver. Here you need to download the "Connector/NET" driver listed in [3], and select the Windows 

installer of version 8.0.19. The installed path is as follows: This driver requires the use of version 4.5.2 of the .NET 

Framework. 

C:\Program Files (x86)\MySQL\MySQL Connector Net 8.0.19\Assemblies\v4.5.2 

Create a new project WinAlarmMySQL, right-click the project, project properties --> application --> target framework, 

select .NET Framework 4.5.2. If the machine does not have this version of the framework, click "Install other 

frameworks", go to the Microsoft site to download the corresponding The Windows framework can install the software. 

Add a reference to MySql.Data.dll in the References section of the project properties. 

An ADO.NET DataSet is an in-memory representation of data that provides a consistent relational programming model 

independent of the data source. Data set represents the entire data set, which contains tables, constraints, and 

relationships between tables. Because a data set is independent of a data source, a data set can contain data local to the 

application, or it can contain data from multiple data sources. Interaction with existing data sources is controlled through 

the data adapter. The relationship between data det, data adapter and data source is shown in Figure 2. 

This article uses the database model shown in Figure 2 to read and write data. Import (Imports) MySql.Data and 

MySql.Data.MySqlClient classes respectively in the project. The MySQL driver provides the 

MySqlConnectionStringBuilder class to build the connection string. After generating the instance builder of the object, 

you can pass in the user name, password, server name, port number and database name, and obtain the connection string 

conn through the ConnectionString property of the builder. As follows, the statement (17) gets the adapter instance 

adapter. The first parameter passed in is the SELECT statement sql, and the second parameter conn is the connection 

string containing the user name and password. Statement (18) generates the data set instance ds, which has no data in it. 

The statement (19) fills the data into ds through the Fill method, and the statement (20) obtains the data table object dt, so 

that the two-dimensional relationship table can be modified, added and deleted simply through the dt object. However, 

the operation on dt is limited to memory, and the data can be written to the data source by calling the function (21). The 

"Access database class" designed in the literature [4] introduces in detail the method of using the DataAdapter to operate 

the two-dimensional database, which can be used to operate the MySQL database with a little modification. 

adapter = New MySqlDataAdapter(sql, conn)       (17) 

ds = New DataSet()          (18) 

adapter.Fill(ds)           (19) 

dt = ds.Tables(0)           (20) 

adapter.Update(ds, dt.TableName)         (21) 

 

BUILD WEB APPLICATIONS 

In the teaching process of "Java programming", the free eclipse version is generally used as the development tool. Here, 

the compressed package of the document [5] is selected, which can be used directly after decompression. But you need to 

install JDK first, and complete the configuration. Building web applications is a skill that every software engineering 

student must master. This version of eclipse cannot be used to develop web applications. You need to select the current 

Install the "Web, XML, Java EE and OSGI Enterprise Development" plug-in, and open the Progress window to view the 

installation progress. During the installation process, you will be reminded whether to install unsigned software, and you 

can choose to agree to all. After the installation is complete, more than 400 plugins will be added to the plugins directory. 

Data Set 

 
Data Adapter 

 
 Data Source 

 
 

Fig. 2 Relations of Data Set, Data Adapter and Data 

Source 
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Regarding the date and version number of eclipse, you can view it through the "About Eclipse IDE" sub menu under the 

main menu Help. 

After installing the Web plug-in, eclipse can create a "Dynamic Web Project", that is, a web application. But the web 

application requires a web server. Here, we also use free Tomcat. Download the compressed version from the document 

[6] and use it after decompressing. There is a default port setting in the server.xml file in the conf subdirectory (default 

8080), if it conflicts with other software, you can adjust it here. Execute the startup command in the bin sub directory to 

start the web service, so that the default homepage of Tomcat can be opened in the browser. 

In the process of developing web applications, Tomcat is not started through the startup command, but through the 

development environment eclipse itself. Therefore, it is necessary to establish the association between eclipse and 

Tomcat, that is, to carry out the necessary configuration. Start from the main menu, Window->Preferences->Server -

>Runtime Environment->Add, add Apache Tomcat 9.0, and check Create a new local server. Then right-click on the 

created web project, Java Build Path->Libraries->Add Library->Server Runtime, next select Apache Tomcat v9.0. Hence 

eclipse establishes an association with Tomcat, and adds Tomcat's class library support. 

 

Web applications are inseparable from the database, and the MySQL database is popularly used here. Therefore, the 

corresponding Java driver is also required. Download the compressed version from the document [7]; select "Platform 

Independent (platform independent)" in the operating system column, and decompress it. Then copy the driver package 

"mysql-connector-java-8.0.17.jar" to the WebContent\Web-INF\lib directory of the new Web project. The following is 

the key code for querying the database. The url includes the IP address, the open port and the database name firstdb. The 

sql indicates the query data table grade, and finally the data set object rs is obtained. All data can be listed through a loop 

(the code is omitted).  

Class.forName("com.mysql.cj.jdbc.Driver"); 

String url = "jdbc:mysql://192.168.1.105:3306/firstdb"; 

Connection conn = DriverManager.getConnection(url, "root", "123456"); 

Statement stat = conn.createStatement(); 

String sql = "select * from grade"; 

ResultSet rs = stat.executeQuery(sql); 

 

 

DEPLOY WEB APPLICATION 

After the web application is developed, it needs to be deployed to the server (Raspberry Pi). First install the Java 

environment through the command (22) (no configuration is required), then download the Linux version of the Tomcat 

compressed package from the document [7], decompress it and put it in the "/usr" directory of the Raspberry Pi. 

sudo apt-get install oracle-java8-jdk                    (22) 

Run the "./startup.sh" script in the bin subdirectory of Tomcat to start Tomcat, and you can access the local home page 

from the browser. In order to be accessible from other computers, the default port 8080 needs to be opened using the ufw 

tool. Close Tomcat and execute the corresponding "./shutdown.sh" script. Now we just start and close Tomcat manually. 

After the Raspberry Pi is put into use, it needs to be started automatically. You can build a service script (named my-

tomcat.sh) in the /etc/init.d directory. When starting the service, run the startup script; when closing Tomcat, run the 

shutdown script. Execute the command (23) to set the service script to be runnable, add the service to the system 

management through the command (24) and set the default startup level, and the command (25) allows it to be 

automatically started as a system service. 

sudo chmod +x /etc/init.d/my-tomcat.sh        (23) 

sudo update-rc.d my-tomcat.sh defaults        (24) 

Fig. 3 Result Interface of Tomcat and MySQL 
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sudo systemctl enable my-tomcat.sh                                    (25) 

Export the Web project TestMySQL.war from the previous section, log in to the Raspberry Pi using the FTP tool 

introduced in Section 2, upload the Web project to the Raspberry Pi through the put command and copy it to the webapps 

subdirectory of Tomcat, and restart the Raspberry Pi. The effect of running the browser on other computers is shown in 

Figure 3. Tomcat is automatically started after booting, and it has also successfully accessed the MySQL database. 

 

TEACHING APPLICATION 

Working in a software company often involves working with different operating systems and collaboration between 

multiple employees. As a software engineering student, if you only have one windows computer for four years in college, 

which is used both as a client and a server, the software deployment boundaries are not obvious, and the intuitive 

experience is not deep enough. Moreover, the client and the server are located on a single computer which results to 

various conflicts. Introducing the Raspberry Pi into the teaching practice of software engineering can be used to 

familiarize yourself with the Linux operating system and corresponding software development at a low cost. After 

configuring the Wi-Fi wireless connection, only the Raspberry Pi and the power adapter are needed to provide SSH login 

which makes us familiar with shell commands and simple code writing; file transfer between desktop. Raspberry Pi does 

not require the use of a cumbersome U disk, we can just use the FTP function; we can operate the Raspberry Pi, install it 

on the SSH client and uninstall the software and operate the MySQL database. We can also deploy the web application to 

the Raspberry Pi, making it function as a web server, reading and writing data in MySQL in the web application. 

The VNC Viewer software can act as a VNC client to connect to the VNC Server. After the connection is successful, the 

software on the server can be operated on the client, just like the local operation. However, the client and the server must 

be located in the same network segment, and can be connected to the same TP-LINK wireless router through Wi-Fi and 

address binding. Open the VNC Viewer, enter the IP address of the VNC Server, enter the username and password after 

the connection is successful, and choose to automatically save the password, and the automatic connection will be 

completed next time it is started. The VNC Viewer can be downloaded from [5], both for Linux for Raspberry Pi and for 

Windows for PC. 

Using the VNC server and client, we can remotely control the Raspberry Pi without a monitor, keyboard and mouse, 

which is very convenient in teaching practice. In addition, the Raspberry Pi switch software can also be extended. Instead 

of using the VNC Server, the Socket Server code is embedded in the software, and the Socket Client software is designed 

on the PC side to directly establish a connection with the Raspberry Pi switch software, in order to realize remote 

monitor. 

 

CONCLUSION 

The Raspberry Pi uses the Linux operating system, which is inexpensive and easy to carry. As long as it is connected to 

Wi-Fi and provided with power, it can be used as a variety of servers and shared within a small area, which is especially 

suitable for software engineering students to practice software in the dormitory. This article focuses on providing the 

solution of using Visual Basic .NET to call MySQL database, as well as the key code and project deployment scheme of 

using Java to call MySQL database in Web applications. In addition, the Raspberry Pi can also install the visual Code 

Blocks development environment with one command to practice the underlying software development of the Linux 

operating system. The Python development tools that come with Raspberry Pi can be widely used in AI development, 

hardware design and operation [9]. 
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